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Overview of Cisco DNA Center AI-Enhanced RRM 

AI-Enhanced RRM is the next evolution of Cisco’s award-winning radio resource management (RRM). RRM was 

originally introduced with Cisco® AireOS and the Cisco Aironet® access points in 2005 and managed the 

complexities of RF from Wi-Fi 1 through 6 and now Wi-Fi 6E. RRM has fluidly grown to include innovative 

algorithms such as Flexible Radio Architecture (FRA) and Dynamic Bandwidth Selection (DBS) to the traditional 

algorithms of Dynamic Channel Assignment (DCA) and Transmit Power Control (TPC).  

On a Cisco Catalyst™ 9800 Series Wireless Controller, traditional RRM runs as a service. Cisco RRM manages 

the RF group (the components making up the RF network) based on dynamic measurements between every 

access point (AP) and its neighbors. This information is stored in a local database on the RF group leader 

controller. At runtime, RRM draws on the last 10 minutes of collected data and gently optimizes based on the 

current network conditions. Cisco RRM has proven to be extremely effective and trustworthy over the years, 

and when configured correctly for the type of RF network coverage desired (capacity vs. coverage) it can 

adapt to almost any size or deployment density. In Wi-Fi, RF conditions can dynamically change with different 

network loads, numbers of devices, and numbers of users in the environment. RRM has continued to measure 

up well to this task, with caveats that do require some learning for the environment being tuned.  

Enter Cisco’s AI-Enhanced RRM. AI-Enhanced RRM integrates the power of artificial intelligence (AI) and 

machine learning (ML) into the reliable and trusted Cisco RRM product family algorithms in the cloud. AI-

Enhanced RRM is coordinated through Cisco’s DNA Center (an on-premises appliance) as a service. Existing 

Cisco Catalyst 9800 RRM sites can be seamlessly transitioned to an intelligent, centralized service. As with 

other Cisco DNA Center services, AI-Enhanced RRM brings a host of new features with it. The Cisco DNA 

Center RRM control center allows administrators to quickly assess the health and performance of the RF 

coverage, from the enterprise level all the way down to a single site or building level.  

Cisco AI-Enhanced RRM is different, as it brings the ability to analyze historical dynamic RF data over time. The 

ability to evaluate complex RF data often comes down to being able to factor in local knowledge of “normal” 

against the currently displayed data. “Normal” can and does vary from site to site based on the equipment 

choices and architectural design vs. the client density.  

After an initial learning period, the Cisco AI Analytics Cloud will begin to provide insights into the performance 

and tuning of the RF network. Insights provide granular guidance on:  

● Performance against service-level agreements (SLAs)  

● The effectiveness of present settings and configurations  

● The quality of the coverage  

Together, the AI-Enhanced RRM algorithms, with the power of the Cisco AI Analytics Cloud, and Cisco DNA 

Center take Wi-Fi RF management to an unprecedented level that correlates 24x7 observations from the 

network and the client devices themselves and applies 20+ years of Cisco RF excellence to drive exceptional 

user experiences into the future.  
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Cisco AI-Enhanced RRM data flows and functional components  

Cisco AI-Enhanced RRM operates as a distributed RRM service. RF telemetry is collected from the Cisco 

Access Points by the Catalyst wireless controller (WLC) and passed through Cisco DNA Center to the Cisco AI 

Analytics Cloud, where the data is stored. The RRM algorithms run against this telemetry data stored in the 

cloud. AI analyzes the solutions and passes any configuration change information back to Cisco DNA Center. 

Cisco DNA Center maintains the control connection with the enrolled Catalyst 9800 and passes any individual 

AP configuration changes back to the APs. The Cisco AI Analytic Cloud operates just like the WLC RF group 

leader does on the controller today, but with much more storage, compute power, and intelligent analysis.  

Networkwide holistic optimizations are performed by the RRM Resource Analytics Engine, which focuses on 

dynamically created groups of radios (clusters) to optimize local performance without falling victim to the pitfalls 

of greedy optimizations that could lead to cascading network changes and potential network disruptions. 

Algorithms for DCA, TPC, FRA, DBS, and basic service set (BSS) color are some examples of the types of 

optimizations performed. These algorithms are latency tolerant and lend themselves well to management within 

the Cisco DNA Center ecosystem. 

The RRM Edge Compute Engine focuses on latency-sensitive and client-specific optimizations. Examples of 

these types of services include optimized roaming, dynamic frequency selection (DFS) optimizations, coverage 

hole detection and mitigation, event-driven RRM (EDRRM), and dynamic DFS. These functions are maintained 

on the local WLC, with telemetry data being sent to the AI-Enhanced RRM Analytics Engine. This analysis will 

provide optimization guidance and insights to the RRM Control Center to help administrators further optimize 

the configurations and monitor performance. 

The Cisco AI Analytics Cloud provides the core support to Cisco DNA Center for AI-Enhanced RRM core 

services as well as ML features. The architecture supports the methods and framework necessary to create a 

seamless upgrade path for existing customers to benefit from adaptive RRM optimizations and finally simplify 

customer configurations using intent-based RRM workflows through both local and cloud-based Catalyst 9800 

WLCs.  
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Figure 1.   

AI-Enhanced RRM architecture and data flow  

Recommended software 

● Cisco DNA Center Release 2.3.4 

● Cisco WLC and AP Release Cisco IOS® XE 17.9.3  

Table 1. Cisco DNA Center and device compatibility matrix 

Cisco DNA Center release WLC release/Cisco IOS XE 

2.3.2.x 17.7.1 

2.3.3.x 17.8.1 

2.3.4.x or later 17.9.3 
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Table 2. Cisco DNA Center package requirement 

Cisco DNA Center package requirements Minimum supported package version Recommended package version 

AI Network Analytics 2.8.8.306 2.9.21.398 

Assurance Base 2.3.2.108 2.3.3.382 

Note:   This document is based on the recommended Cisco DNA Center Release 2.3.4 and controller/AP 

release of Cisco IOS XE 17.9.3. Some software features are not supported in earlier software releases. 

Supported device software and hardware 

Table 3. Cisco Catalyst wireless controllers that support AI-Enhanced RRM  

Supported Catalyst wireless controllers Minimum supported Cisco 
IOS XE version 

Recommended Cisco IOS XE 
version 

Cisco Catalyst 9800-CL Wireless Controller for Cloud 17.7.1 17.9.3 

Cisco Catalyst 9800-L Wireless Controller 17.7.1 17.9.3 

Cisco Catalyst 9800-40 Wireless Controller 17.7.1 17.9.3 

Cisco Catalyst 9800-80 Wireless Controller 17.7.1 17.9.3 

Table 4. Cisco APs that support AI-Enhanced RRM 

Supported access points Cisco IOS XE software 

Minimum version Recommended version 

Aironet 1540 Series 17.7.1 17.9.3 

Aironet 1560 Series 17.7.1 17.9.3 

Aironet 1815 Series 17.7.1 17.9.3 

Aironet 1830 Series 17.7.1 17.9.3 

Aironet 1840 Series 17.7.1 17.9.3 

Aironet 1850 Series 17.7.1 17.9.3 

Aironet 2800 Series 17.7.1 17.9.3 

Aironet 3800 Series 17.7.1 17.9.3 

Aironet 4800 Series 17.7.1 17.9.3 

Catalyst 9105AX Series 17.7.1 17.9.3 

Catalyst 9115AX Series 17.7.1 17.9.3 
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Supported access points Cisco IOS XE software 

Minimum version Recommended version 

Catalyst 9120AX Series 17.7.1 17.9.3 

Catalyst 9130AX Series 17.7.1 17.9.3 

Catalyst 9124AX Series 17.7.1 17.9.3 

Catalyst IW6300 Heavy Duty Series 17.7.1 17.9.3 

6300 Series Embedded Services 17.7.1 17.9.3 

Catalyst 9136 Series 17.7.1 17.9.3 

Catalyst 9164 Series  17.9.3 17.9.3 

Catalyst 9166 Series  17.9.3 17.9.3 

Catalyst 9162 Series  17.9.2 17.9.2 

Day-0 configuration: Setting up Cisco DNA Center to use AI-Enhanced RRM 

The following subsections provide step-by-step instructions for setting up the day-0 configurations necessary 

to begin using AI-Enhanced RRM. 

Install the AI Network Analytics package onto Cisco DNA Center 

Cisco DNA Center provides the option to download a couple of packages called AI Network Analytics and 

Assurance – Base.  

To download and install this package, follow the steps below:  

● Click the hamburger menu  in the top left corner of the screen. Click System, then Software Updates. 

● Click Installed Apps on the left side of the screen. 

● Scroll down to Assurance and you will find the AI Network Analytics and Assurance – Base packages 

ready for download and installation (Figure 2). 

Note:   If you do not see the AI Network Analytics and Assurance – Base packages after performing the 

steps above, please reach out to either a Cisco account sales representative or an account sales engineer 

for additional support.  
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Figure 2.   

Location of the AI Network Analytics package within the Software Updates page 

Prepare the Catalyst 9800 wireless controller 

Configure NETCONF 

For discovery and inventory, Cisco DNA Center uses NETCONF. Ensure that NETCONF is configured before 

adding to the Cisco DNA Center inventory.  

● The required configuration for NETCONF and AAA authorization: netconf-yang  

◦ aaa new-model  

◦ aaa authorization exec default local  

● If using an authentication, authorization, and accounting (AAA) server to authenticate the user 

credentials, make sure the NETCONF user returned from AAA is defined with privilege 15.  

Verify RF Grouping 

A Catalyst 9800 WLC in RF Grouping mode with static roles (Static Leader and Static Member), along with 

WLCs in Automatic mode (Auto Leader and Auto Member), should support transformation into remote members 

of the AI-Enhanced RRM RF group leader. 

Note:   If the controller is configured as a Static Leader and there are member controllers assigned to it, 

make sure that the member controllers have the same RRM configuration and RF profile settings before 

changing the leader configuration to Auto. Once this configuration is set to Auto, all the previous grouped 

controllers will automatically negotiate a new RF group leader, and the RF group leader will use the new RF 

group leader controller’s RRM configurations. 
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Figure 3.   

Changing the RF Grouping mode to Automatic on the Catalyst 9800 wireless controller  

Verify Radio settings  

In addition to setting RF Grouping to Automatic, ensure that RF Channel Assignment and Tx Power Level 

Assignment for all radios are operating in Global Assignment mode (Automatic) and are not set to a static value 

on the AP radio. Although this is encouraged but not mandatory, a subset of the radios can be on a static 

channel, and power settings and AI-Enhanced RRM will simply work on the other set of radios under 

automation mode. 

To do this, navigate to Configuration > Access Points and expand the 6 GHz, 5 GHz, and 2.4 GHz Radios drop-

down. If the Channel and Power Level values contain an asterisk (*), they are operating in Global Assignment 

mode and will be managed by AI-Enhanced RRM. Manage any radios that do not have an asterisk through the 

radio configuration dialog and set the channel and power back to Global.  
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Figure 4.   

Location of access point radios on the Catalyst 9800 wireless controller 

 

Figure 5.   

Verifying the asterisk (*) in the channel and power level assignments in the radios table 
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Figure 6.   

Setting the assignment method for the channel and TX power level to Global for RRM 

Note:   Combination of Policy/Site/RF Tags used in set of Access Points will be grouped into 1 Network 

Profile in Cisco DNA Center. Any Policy/Site/RF Tag not assigned to any Access Points will not be learned 

by DNA Center while doing a Learn Device config workflow. Make sure to add atleast 1 Access Point per 

unique Policy/Site/RF tag combination on the controller. This will help in any future deployment with these 

combinations created. 

Part 1: Build a site hierarchy 

Description: Cisco DNA Center’s Design page provides a robust design application to allow customers of every 

size and scale to easily define their physical sites and common resources.  

Section goals: Create and configure network hierarchy sites and settings to define shared services, device 

credentials, and Simple Network Management Protocol (SNMP) community strings. 

Note:   If your site hierarchy is already defined or exported from Cisco Prime® Infrastructure, you can skip 

to Part 2. 
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Step 1: Navigate to the Network Hierarchy page 

Click the hamburger menu  in the top left corner of the screen. Click Design, then Network Hierarchy 

(Figure 7). 

 

Figure 7.   

Displaying the network hierarchy 

Step 2: Create sites, buildings, and floors 

To allow Cisco DNA Center to group devices based on location, begin by laying out a hierarchy of areas, 

buildings, and floors as required to accurately represent the location of your network. A site hierarchy lets you 

enable unique network settings and IP spaces for different groups of devices.  

● Option 1: To create a site, click the Add Site button (Figure 8). A menu will open and provide you an 

option to create a child area, building, or floor within a desired site.  

● Option 2: To create a site, click the gear icon (Figure 9) next to the site you would like to create a child 

site under. 

● When creating a floor, click Upload file to upload a floor of a building (Figure 10). 

Floor plans must be in DXF, DWG, JPG, GIF, or PNG format. 

The behavior of Cisco DNA Center is for settings from the global level to be inherited into subsequent levels in 

the hierarchy. This enables consistency across large domains while providing administrators the flexibility to 

adapt and change an individual building or floor. 

Notes:  

● You can create areas and buildings only within the global site or other areas and can create floors only 

within buildings. 

● When creating a building within the design hierarchy, it is critical that you use a real physical street 

address for your sites. Cisco DNA Center uses the street address to select the country code for the 

wireless implementation. 

Refer to Design the Network Hierarchy in the Cisco DNA Center User Guide for more details on how to create 

a network hierarchy or migrate your existing network hierarchy from Cisco Prime.  
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Figure 8.   

Clicking Add Site within the Network Hierarchy page 

 

Figure 9.   

Clicking the gear icon next to a site within the Network Hierarchy page 

 

Figure 10.   

Location of the Upload file button to upload a floor plan during floor creation 
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Part 2: Discovery and inventory 

Cisco DNA Center’s Discovery application allows a network administrator to add their network device to the 

platform. 

Section goals: Discover WLC and APs and assign them to the site created in the previous section.  

If you already have the WLC and APs in inventory, you can skip ahead to the Part 4, Learn an Existing 

Deployment.  

Step 1: Navigate to the Network Settings page 

Cisco DNA Center lets you save common resources and settings with the Network Settings application. 

Information pertaining to the enterprise can be stored and reused across the network.  

● To navigate to the Network Settings page, open the hamburger menu  in the top left corner of the 
screen. Click Design, then Network Settings (Figure 11). 

 

Figure 11.   

Location of Network Settings from the hamburger menu 

Step 2: Configure network settings and device credentials 

This is where you configure all device-related network settings. By default, Cisco DNA Center’s IP address is 

prepopulated in the Syslog Server and SNMP Server fields. This will enable syslog and SNMP traps to be sent 

to Cisco DNA Center from network devices when a WLC is added to Cisco DNA Center.  

● Click the Device Credentials tab to view the existing device command-line interface (CLI) credentials 

and SNMP community strings (Figure 12).  

● Click Add to create new credential entries (Figure 13). Cisco DNA Center uses these credentials to 

discover the network devices. 
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Figure 12.   

Workflow to add device credentials to the network settings 

 

Figure 13.   

CLI Credentials form that appears when you click Add in the previous figure 

Step 3: Add device to inventory 

● Option 1: Click the hamburger menu ( ) in the top left corner of the screen. Click Inventory, then Add 

Device. 

● Option 2: From the homepage, scroll down to the bottom and click Discovery and then Add Discovery 

(Figures 15 and 16). 
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Figure 14.   

Option 1: Add the Catalyst wireless controller details 

 

Figure 15.   

Option 2: Location of Discovery button on Cisco DNA Center homepage 
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Figure 16.   

Option 2: Location of Add Discovery button on Discovery page 

Step 4: Discover controllers and access points in Cisco DNA Center 

To discover a WLC in Cisco DNA Center, follow the steps below (Figure 17):  

● Enter a discovery name (any unique name for the purpose of classification on the Discovery page).  

● Enter either a single IP address or a range of addresses and specify Cisco Discovery Protocol (CDP), IP 

Address/Range, or Link Layer Discovery Protocol (LLDP).  

● Enter the SSH username and password and SNMP read and write credentials (click Add Credentials to 

do so). 

● Enter the NETCONF port as 830.  

● When the details are filled in, click the Discover button. 

Notes: 

● When you discover a WLC, all the joined APs will also be discovered and placed in Cisco DNA Center’s 

inventory. 

● All the CLI credentials defined in the Design section are displayed on the Discovery page.  
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Figure 17.   

Discovery page with credentials filled in and ready for discovery  

● After the discovery process completes, ensure that the status of the Internet Control Message Protocol 

(ICMP), SNMP, NETCONF, and CLI sections is green for every device that has been discovered.  
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Figure 18.   

Successful discovery of WLC on the Discovery page 

Step 5: Navigate to Inventory 

After the discovery process is complete, navigate to the Inventory application, where your discovered devices 

will be located.  

● Open the hamburger menu ( ) and click Provision and then Inventory (Figure 19). 

 

Figure 19.   

Location of Inventory within the hamburger menu 
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● Click Unassigned Devices on the left side of the page and ensure that all devices are Reachable and 

that the Manageability status is Managed (Figure 20).  

It is critical that all devices be in the Managed state for Cisco DNA Center Assurance functionality to work. If 

they are not, check the reachability of your devices. 

 

Figure 20.   

Discovered devices and their Reachability and Manageability status  

Refer to Discover Your Network in the Cisco DNA Center User Guide for more details on how to discover and 

add your Cisco device to the Cisco DNA Center Inventory.  

Part 3: Enable Cisco AI-Enhanced RRM 

Cisco DNA Center’s Cisco AI Analytics page provides an option to enable all AI Analytics features and allows 

you to select a cloud cluster where the data will be store for AI algorithms to process.  

Section goals: Enable AI-Enhanced RRM and choose a cloud cluster where your data will be stored 

Step 1: Navigate to the Cisco AI Analytics page 

● Click the hamburger menu ( ) in the top left corner of the screen. Click System, then Settings. 

● Navigate to Cisco AI Analytics on the sidebar as shown.  

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-3/user_guide/b_cisco_dna_center_ug_2_3_3/b_cisco_dna_center_ug_2_3_3_chapter_010.html
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Figure 21.   

Settings location 

 

Figure 22.   

Location of the Cisco AI Analytics page on the Cisco DNA Center homepage 
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Step 2: Enable AI-Enhanced RRM 

To allow Cisco DNA Center to turn on AI-Enhanced RRM, you need to: 

● Enable AI Network Analytics and AI-Enhanced RRM 

● Select the closest or preferred cloud cluster to store your cloud data  

● Make sure the cloud connection status is green and click Enable  

 

Figure 23.   

Enabling AI Network Analytics and AI-Enhanced RRM 
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Figure 24.   

Selecting the cloud cluster 

Part 4: Learn an existing deployment  

The focus here is for Cisco DNA Center to learn all wireless configurations from the existing Cisco IOS XE 

wireless controller. The “Learn Device Configuration” workflow will help you learn the necessary configurations, 

RF profiles, SSIDs, and other information from the newly added WLC and translate these to the Cisco DNA 

Center network settings.  

Refer to Create Network Profiles for Wireless in the Cisco DNA Center User Guide for a new wireless 

deployment using Cisco DNA Center. 

Before you begin: 

● Make sure that you have the Cisco Catalyst 9800 Series Wireless Controller in the inventory. If you do 

not, discover devices using the Discovery feature, as described in Part 2.  

● Ensure that the Catalyst 9800 Series Wireless Controller is reachable and in a Managed state within the 

Inventory window. For more information, see About Inventory in the Cisco DNA Center User Guide.  

● Design your network hierarchy by adding sites, buildings, and floors so that you can later easily identify 

where to apply design settings or configurations. You can either create a new network hierarchy or, if 

you have an existing network hierarchy on Cisco Prime Infrastructure, import it into Cisco DNA Center 

(Part 1).  

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-3/user_guide/b_cisco_dna_center_ug_2_3_3/m_configure-network-profiles.html#id_94371
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For more information about importing and uploading an existing network hierarchy, see Upload an Existing Site 

Hierarchy in the Cisco DNA Center User Guide. 

For more information about creating a new network hierarchy, see Create a Site in a Network Hierarchy, Add a 

Building, and Add a Floor to a Building in the Cisco DNA Center User Guide. 

Section goals: Create wireless network profiles in Cisco DNA Center using an existing Catalyst 9800 wireless 

controller. 

Step 1: Launch the Learn Device Configuration workflow 

From the hamburger menu ( ) in the top left, click Workflows. Then open the Learn Device Configuration 

workflow. 

 

Figure 25.   

Learn Device Configuration workflow 

Step 2: Select the WLC from which you wish to learn the configuration  

In the Select a WLC to Learn Configuration window, click the wireless controller whose configurations have not 

been learned by Cisco DNA Center and click Next. 

Note:   Make sure your controller is not provisioned or learned.  

Caveat: The only way to use Learn Device Configuration to learn the configuration of a controller that is already 

provisioned is by deleting the Catalyst 9800 wireless controller from Inventory and adding it back.  

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-2-3/user_guide/b_cisco_dna_center_ug_2_2_3/b_cisco_dna_center_ug_2_2_3_chapter_0110.html#task_a2p_qtb_yz
https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-2-3/user_guide/b_cisco_dna_center_ug_2_2_3/b_cisco_dna_center_ug_2_2_3_chapter_0110.html#task_a2p_qtb_yz
https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-2-3/user_guide/b_cisco_dna_center_ug_2_2_3/b_cisco_dna_center_ug_2_2_3_chapter_0110.html#task_zdk_k2d_wy
https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-2-3/user_guide/b_cisco_dna_center_ug_2_2_3/b_cisco_dna_center_ug_2_2_3_chapter_0110.html#task_zdk_k2d_wy
https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-2-3/user_guide/b_cisco_dna_center_ug_2_2_3/b_cisco_dna_center_ug_2_2_3_chapter_0110.html#task_orv_3ct_b1b
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Figure 26.   

Selecting the existing WLC 

Step 3: Select sites that are NOT associated with the WLC 

In the Site Assignment window, select sites that aren't associated with the existing wireless network profiles for 

wireless controllers and APs. (Figure 27). 

Note:   While you can learn device configuration without site assignment, we recommend that you assign 

sites, which is required to manage the same wireless controller from Cisco DNA Center.  

● To assign a site to a wireless controller, click Assign Site next to the device name. 

◦ In the Assign Site window, navigate to the building that you want to associate and click Save. 

● To assign sites to an AP, check the checkbox next to the AP name in the Unified APs table and click 

Assign Site. 

◦ In the Assign Site window, navigate to the floor and click Save. 

● Click Next. 

Note:   Only sites that do not have any wireless configurations or profiles associated to them can be 

overwritten. If there is no fresh site, exit from the current workflow, create a new site, and then restart the 

workflow. 
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Figure 27.   

Assigning a site to the WLC and APs 

Step 4: Review the learned configurations 

In the Assign Sites to Configurations Learned window, you can view the following learned configurations if the 

configuration is available on the device. The configurations that aren’t assigned to sites are ignored.  

● Flex override 

● AAA server 

● VLAN entry 

● Mesh configuration 

● Enable remote teleworker 
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Figure 28.   

AAA VLAN, mesh, and all Flex VLAN configurations that are learned in from an existing configuration 

Step 5: Enter the shared secret for all TACACS/AAA servers 

In the Learned Network Settings window, review the following learned network settings. These settings are 

saved to the physical location of the device. The network servers that are displayed in this window are saved at 

the site level. This includes Cisco ISE and all other RADIUS servers that are a part of the existing wireless 

controller.  

● Enter the shared secret for AAA servers. 

● System Settings 

◦ To save an AAA server as a Cisco ISE server, click the Cisco ISE Server toggle button and enter the 

username, password, and FQDN details. 

Note:   If the Cisco ISE server is already present on Cisco DNA Center, you cannot save an AAA server as 

a Cisco ISE server. 

After configuring an AAA server as a Cisco ISE server, the certificate from the Cisco ISE server is automatically 

accepted to establish the trust. 

● Click the Virtual IP Address(es) toggle button to enter the load balancer IP address. 
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Figure 29.   

Entering the shared secret for all AAA servers 

 

Figure 30.   

AAA server for a site in Network Settings on Cisco DNA Center (post-learn) 
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Figure 31.   

List of AAA/RADIUS servers on the Catalyst 9800 wireless controller (pre-learn) 

● AAA Server: Shows the network servers configured on Cisco DNA Center. These network servers are 

prepopulated. 

◦ You can customize the network or client/endpoint for the AAA server. The servers and protocols are 

chosen by default. 

◦ From the drop-down list, choose IP Address (Primary) and IP Address (Secondary). These servers 

are saved at the global level. 

◦ DHCP Server: Shows all the Dynamic Host Configuration Protocol (DHCP) servers available on the 

device. 

◦ NTP Server: Shows all the Network Time Protocol (NTP) servers available on the device. 

◦ Click Next. 

Note:   The following caveats apply, as Cisco DNA Center allows only one Cisco ISE and one virtual IP 

(VIP) server. If you have multiple RADIUS servers added to your Catalyst 9800 wireless controller, you will 

have to add them as AAA or TACACS servers.  



 

© 2023 Cisco and/or its affiliates. All rights reserved. Page 30 of 92 

 

Figure 32.   

Selecting primary and secondary AAA and RADIUS servers 

Step 6: Verify all learned wireless configurations  

In the Learned Wireless Configuration window, review the configurations learned from the wireless controller. 

The wireless configurations that appear in this window are saved at the global level.  

● The Supported tab shows the list of learned configurations, such as SSID, RF profiles, interfaces, 

interface groups, aWIPS and forensic capture enablement, pre-auth ACLs, and native VLAN. 

◦ By default, the network access control (NAC) configuration-enabled SSIDs are learned as guest 

SSIDs. Click the Edit icon next to the SSID Type in the SSIDs table to change the SSID type from 

Guest to Enterprise.  

◦ To ignore the configuration, select the checkbox next to the learned configuration and click Ignore 

Config in the corresponding table. 

◦ To relearn an ignored SSID, RF profile, interface, or interface group, select it and click Relearn Config 

in the corresponding table. 

◦ All learned SSIDs without any passphrases are listed in the Supported section of the Learned Wireless 

Configuration window. 

Note:   If you have Ignored any Config, make sure add the Ignored config CLI Template to the Wireless 

Controller in Provisioning Wireless Controller And Access Point section.  
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Figure 33.   

Learned wireless configurations 

● All Cisco DNA Center-supported RF profiles are listed here, with all bands, supported data rates for each 

band, and preferred channel width. It also lists all systems and custom-created RF profiles. 

● These learned RF profiles can be found in the global site hierarchy, accessed by going to the hamburger 

menu ( ) and choosing Design > Network Settings > Wireless. 

● This list should include all the RF profiles from the Catalyst 9800 wireless controller located in 

Configuration > Tags & Profiles > RF/Radio > RF, as shown in the figures below. 

● A new RF profile will be pushed to the Catalyst 9800 wireless controller in the further steps after the AI 

RF profile is created. 
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Figure 34.   

Learned wireless configurations (RF profiles) 

 

Figure 35.   

RF profiles on Cisco DNA Center in Network Settings > Wireless tab (post-learn) 
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Figure 36.   

RF profiles on the Catalyst 9800 wireless controller (pre-learn) 

● All wireless and wired interfaces from the Catalyst 9800 wireless controller (Figure 39) are listed here.  

● These interfaces will automatically be mapped to any existing SSIDs and Flex groups on the wireless 

controller.  

● Interfaces can also be used for any newly created SSID as well. 

◦ These wireless interfaces can be found in the global site hierarchy, accessed by going to the 

hamburger menu ( ) and choosing Design > Network Settings > Wireless (Figure 38). 
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Figure 37.   

Learned wireless configurations (interfaces) 

 

Figure 38.   

Wireless interfaces on Cisco DNA Center in Network Settings > Wireless tab (post -learn) 
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Figure 39.   

Interfaces on the Catalyst 9800 wireless controller (pre-learn) 

● Any aWIPS configuration on the Catalyst 9800 wireless controller will be learned here. This configuration 

can be found in the aWIPS profile on Cisco DNA Center, as shown in Figure 41. 

 

Figure 40.   

Learned wireless configurations (aWIPS) 
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Figure 41.   

aWIPS profile in Assurance 

● The Unsupported tab shows the configurations that are not learned, such as SSIDs, RF profiles, 

interfaces, pre-auth-ACLs, and interface groups. You can address these unsupported or unknown 

configurations and use CLI templates. 

Note:   Any unsupported configuration in the Learn Device Configuration workflow will result in Cisco DNA 

Center creating a new policy/site tag for the configuration and pushing it to the controller along with the 

CLI template.  
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Figure 42.   

Unsupported wireless configurations 

Step 7: Enter passphrase to all PSK SSIDs 

In the Assign Sites to Learned SSIDs window, review and resolve any “multiple WLAN profile” conflicts.  

● The SSIDs that are saved at the global level and learned with multiple WLAN profiles are listed. You can 

assign a WLAN profile from each SSID to the global level and another profile to a particular site to 

resolve the conflict. 

● (Optional) To assign a WLAN profile to a site, click Assign Site in the corresponding SSID row. 

◦ In the Assign Site window, choose a site and click Save. 
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Figure 43.   

Learned SSIDs 

 

Figure 44.   

Learned SSIDs on Cisco DNA Center in Network Settings > Wireless tab (post-learn) 
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Figure 45.   

SSIDs on the Catalyst 9800 wireless controller (pre-learn) 

Step 8: Resolve configuration conflicts 

In the Resolve Configuration Conflicts window, review and resolve the available conflicts. 

Configurations learned from the device and the configurations saved at the global level are shown.  

Choose a configuration set to resolve the conflict: 

● Use the Cisco DNA Center configuration to save configurations at the global level.  

● Use the device configuration to learn configurations from the device. 

● Selecting Use Device Configuration overwrites the configurations saved at the global level.  

● Use a custom configuration to customize the configurations by choosing the required wireless interface.  

Note:   If you have a calibarated RF profile for your wireless network, select device configuration instead of 

Cisco DNA Center configuration. 
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Figure 46.   

Resolving configuration conflicts 

Step 9: Select model configurations 

In the Model Configs Learned window, review the model configurations. 

The model configurations are a set of model-based, discoverable, and customizable configuration capabilities 

that can be deployed on network devices. Model configurations can be deployed on various hardware platforms 

and software types. Cisco DNA Center discovers and learns model configurations from device -specific 

configurations such as CLI. The learned model configurations are saved in designs that can be attached to 

network profiles. 

Expand and review the following wireless model configuration design types:  

● AAA Radius Attributes Configuration 

● Advanced SSID Configuration 

● CleanAir Configuration 

● Dot11ax Configuration 

● Event Driven RRM Configuration 

● Global IPv6 Configuration 

● Multicast Configuration 

● RRM General Configuration 
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If you want to ignore any configuration from each model configuration design type, select the configuration in 

the corresponding table and click Ignore Config. To relearn the ignored configuration, select the ignored 

configuration and click Relearn Config. 

Refer to Design Model Configuration in the Cisco DNA Center User Guide for more information on how to create 

and edit network-specific model configurations using the Model Config Editor.  

 

Figure 47.   

Model configurations learned 

Step 10: Add a CLI template to the network profile 

In the CLI Templates Learned window, review the CLI templates and use these templates to address the 

unknown or unsupported configurations. 

● All the ignored WLAN configurations are chosen by default. Click Ignore Template to restrict the 

template from addressing the configurations. Click Relearn Template to address the configurations. 

● All the unknown or unsupported configurations are chosen by default. Click Ignore Template to restrict 

the template from addressing the configurations. Click Relearn Template to address the configurations. 

● These CLI templates can be edited using the Template Editor, accessed by going to the hamburger 

menu ( ) and choosing Tools > Template Editor.  

● These CLI templates will be saved in Cisco DNA Center for current and future use and will not be 

deleted.  

● This CLI template needs to be attached to the network profile while provisioning the Catalyst 9800 

wireless controller. 

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-3/user_guide/b_cisco_dna_center_ug_2_3_3/b_cisco_dna_center_ug_2_3_3_chapter_01001.html
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Figure 48.   

CLI template generated for unsupported and ignored configurations  

Step 11: Review the network profile configuration 

In the Network Profiles window, review the learned network profile configuration. Based on the configurations 

learned, Cisco DNA Center creates the network profile. You can either use the learned network profile or create 

a new network profile. The SSIDs are learned and grouped while creating network profile.  

For Cisco AireOS wireless controllers, the Flex group and AP groups are mapped to the network profile. 

Depending on the AP site assignment, the network profile is assigned to the appropriate site.  

For Cisco Catalyst 9800 Series Wireless Controllers, the site tag, policy tag, and site hierarchy mapped to the 

network profile are displayed. 

● Based on the AP site assignment configuration, the network profile is assigned to the appropriate site. 

Click Sites Assigned to view details on the site assigned to the network profile. 

● To create a new network profile, click Create New Profile. 

The New Profile window appears. 

◦ In the Network Profile Name field, enter a name for the network profile. 

◦ From the SSIDs table, select the checkbox next to the network name to select the SSID.  

◦ Click Save. 
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Figure 49.   

Network profiles created after learning an existing wireless controller’s configuration  

● (Optional) Review the template details and edit if you want to make any changes. 

◦ To assign a site to a network profile, click Assign Site. In the Assign Site window, choose a site and 

click Save. Click Sites Assigned to view the sites assigned to this profile. 

◦ To attach a template to a network profile, click Assign Template. In the Assign Template window, 

choose templates from the Select Templates drop-down list for each device in the existing 

deployment and click Save. Click View Templates to view the templates assigned to the profile. 

◦ To ignore a network profile, click Ignore Profile and then click Continue. If a profile is marked as 

ignored, all the profile attributes of that profile are removed. This cannot be undone by relearning the 

profile. To relearn an ignored profile, click Relearn Profile. 

◦ To add a site tag to a network profile, click Add in the Site Tag table. In the Add Site Tag window, 

choose a site tag from the Select Site Tag drop-down list, choose a site from the hierarchy, and click 

Save. 
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Figure 50.   

Adding a CLI template to a network profile 

Step 12: Review the configuration summary 

In the Summary window, review the following configurations: 

● Device Details 

● Network Setting 

● SSIDs 

● Managed Sites 

● Rolling AP Upgrade 

● Interfaces 

● Advanced Configuration 

Click Save. 

The network configurations are created at the global and site levels appropriately.  
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Figure 51.   

Summary for all learned wireless configurations from an existing wireless controller  

Step 13: Review the newly created network profile 

● Click the hamburger menu icon ( ) and choose Design > Network Profile. 

● The network profiles created from the Learn Device Configuration workflow are listed here.  

 

Figure 52.   

Network profiles created from the learned device configuration 

https://www.cisco.com/c/dam/en/us/td/i/400001-500000/430001-440000/430001-431000/430316.jpg
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● The learned configurations will be pushed to devices when the devices are provisioned.  

● A wireless profile (network profile with wireless configurations) must be assigned to a site before the 

Catalyst 9800 wireless controller is provisioned. This can be done by clicking Assign (as shown in the 

figure below) across your network profile name in the table and selecting all the sites where this network 

profile needs to be assigned.  

● You can click Edit in the Action column next to your network profile names. It will allow you to: 

◦ Change the network profile name if not assigned to any site. 

 

Figure 53.   

Changing the network profile name 

● Have all supported SSIDs for a particular policy tag. You can add an existing SSID from the Cisco DNA 

Center Wireless SSID list in Network Settings. You just need to select the “+” button on the SSID tab and 

add the SSID to the network profile. You also need to select a management interface for the SSID.  
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Figure 54.   

Adding SSIDs in the network profile 

● You can add any model configurations available for the Catalyst 9800 wireless controller by going to the 

Model Configs tab. Refer to Design Model Configuration in the Cisco DNA Center User Guide for more 

information on how to create and edit network-specific model configurations using the Model Config 

Editor.  

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-3/user_guide/b_cisco_dna_center_ug_2_3_3/b_cisco_dna_center_ug_2_3_3_chapter_01001.html
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Figure 55.   

Adding and editing model configurations in the network profile 

● You can add CLI templates from a previous Learn Device Configuration attempt or use a CLI template 

generated from a different device’s Learn Device Configuration learning workflow. This can be done 

from the Templates tab by selecting the “+” and clicking the CLI template to be added to the network 

profile. 
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Figure 56.   

CLI templates in the network profile 

● All site tags, Flex groups, and policy tags associated with this network profile will be listed in Advanced 

Settings. You can add new tags for a new floor on the same site with existing configurations if 

necessary.  

Note:   This space will be blank and will not have any tags if there are unsupported configurations found 

during the Learn Device Configuration workflow, as Cisco DNA Center-created tags will be used by the 

controller and no controller tags are learned thoroughly by Cisco DNA Center. 
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Figure 57.   

Tag details in the network profile 

● You can click Wireless in the steps of the task, as shown below, and all the wireless configurations will 

be listed there. This page can also be accessed by going to the hamburger menu ( ), choosing Design 

> Network Settings > Wireless, and selecting Global in the site hierarchy in the sidebar. 
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Figure 58.   

Wireless settings link in the network profile 

 

Figure 59.   

Wireless settings on the Network Settings page 
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Note:   You can click Template Editor in the steps of the task as shown below and edit a CLI template, 

which can be added to the network profile. You can also access the Template Editor by going to the 

hamburger menu ( ) and choosing Tools > Template Editor). You can also create your own CLI template 

and add it to the network profile.  

 

Figure 60.   

Template Editor from the network profile 

Things to note about the Learn Device Configuration workflow: 

● This configuration will overwrite the existing configurations on the controller and will be managed by 

Cisco DNA Center after provisioning. 

● The workflow will create a new policy tag on the controller if any configuration on the existing AP policy 

tag has any unsupported configuration. 

● The CLI template needs to be attached to the network profile to add all the unsupported SSIDs, RF tags, 

etc. in Step 11 in the Learn Device Configuration workflow in Part 4. 

● This workflow will only learn the configurations from policy, site, and RF tags mapped to the access 

points on the Catalyst 9800 wireless controller. Tags that are not associated with any access point will 

not be saved to Cisco DNA Center. If any tags/profiles need to be a part of future deployment, make 

sure to assign atleast 1 Access Point with the tags which can be learned by this workflow.  

● Only one Cisco ISE server and virtual IP is supported by Cisco DNA Center. Any other RADIUS server 

added to the network has to be either an AAA or TACACS server.  
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Part 5: Create an AI RF profile 

To add a site to the AI-Enhanced RRM service to manage the site’s and APs’ RRM, you must create an AI RF 

profile. If you have learned the profiles and configurations from the controller already (via the Learn Device 

Configuration workflow), you can convert an existing RF profile to an AI RF profile. There is also a workflow for 

creating and assigning an AI RF profile to a site. 

Option 1: Creating AI RF Profile from Network Settings 

● Click the hamburger menu icon ( ) and choose Design > Network Settings > Wireless Tab > Global 
on Sidebar > Scroll down to Wireless Radio Frequency Profile.  

● You can check box an existing RF profile > go to Actions and select Upgrade to AI.  

● To create a brand new AI RF Profile, select +Add > AI RF Profile and customize the AI RF profile 

according to your wireless network requirements.  

● Go to AI RF Profile tab and you will find your newly created AI RF Profile. 

● To assign this AI RF Profile to a site, on your AI RF Profile column click on … then go to Assign 

Locations 

● Select all the building you want to assign this AI RF Profile to and want to use AI-Enhanced RRM then 

select Assign. 

Option 2: Creating AI RF Profile using a Workflow 

Step 1: Create an AI RF profile 

Click the hamburger menu icon ( ) and choose Workflows > Configure AI RF Profile. 

 

Figure 61.   

Workflow to create an AI RF profile 

https://www.cisco.com/c/dam/en/us/td/i/400001-500000/430001-440000/430001-431000/430316.jpg
https://www.cisco.com/c/dam/en/us/td/i/400001-500000/430001-440000/430001-431000/430316.jpg
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Step 2: Assign a name to the task and click Next 

 

Figure 62.   

Creating a task 

Step 3: Select the location to assign the AI RF profile 

AI-Enhanced RRM is enabled at the WLC level globally, just as RRM is. All sites having APs associated with the 

controller but assigned to other buildings will also be managed by AI-Enhanced RRM; this is supported by the 

workflow. All impacted sites will be listed as Impacted and assigned as well.  

Select the site(s) to assign and click Next. 

 

Figure 63.   

Site assignment for the AI RF profile 
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Step 4: Select the AI RF profile to assign 

You can select from a previously configured AI RF profile, or select the Actions menu and choose “Create a 

new AI RF Profile to add” or “Copy the currently assigned RF Profile and AI Settings.”  

 

Figure 64.   

Selecting the AI RF profile 

Step 5: Create a new AI RF profile (6-GHz support starts with Cisco DNA Center Release 2.3.4) 

● Enter a name for the AI RF profile. 

● Select the bands you want your network to operate on. 

● Enter the busy hour of your network and how sensitive your network is to RRM changes.  

● Enable all the algorithms you want to use in this AI RF profile. 

What is the busy hour? It determines when RRM optimizations will occur, based on how sensitive your network 

is to changes: 

● High sensitivity: RRM optimizations will occur whenever RF improvements are possible.  

● Medium sensitivity: RRM optimizations will occur less frequently than for a high sensitivity setting.  

● Low sensitivity: RRM optimizations will be deferred until after the configured busy hour.  

Note: Sensitivity outside the configured busy hour is equivalent to high sensitivity.  

An AI RF profile contains the same elements as a legacy controller-based RF profile but adds configurations for 

services and other elements that will be subscribed to.  
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The services include:  

● FRA: Flexible Radio Assignment (not supported in 6 GHz as of Cisco DNA Center Release 2.3.4) 

● DCA: Dynamic Chanel Assignment  

● TPC: Transmit Power Control  

● DBS: Dynamic Bandwidth Selection 

Note:   At least one of the four AI-Enhanced RRM services (FRA, DCA, TPC, and DBS) must be enabled to 

onboard a site in the AI-Enhanced RRM service.  

Any changes or corrections can be made at this time and saved. The profile exists only on Cisco DNA Center at 

this point. Until the devices are provisioned and have profiles (either classic or AI) selected and pushed, no 

changes are made to the controllers or the associated APs’ operational configurations.  

When satisfied, select Save to complete the action. Upon saving you will be returned to the AI RF profiles main 

screen showing the results of the actions. 

 

Figure 65.   

Creating an AI RF profile 
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Figure 66.   

Advanced AI RF profile configurations for DCA and DBS 

 

Figure 67.   

Advanced AI RF profile configurations for TPC and data rate support  
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Step 6: Assign an AI RF profile to a site 

Select an AI RF profile to assign to the site, as shown in Figure 68.  

 

Figure 68.   

Selecting an AI RF profile 

Step 7: Review and verify the summary 

On the summary page, all the configurations from the AI RF profile will be listed, along with the site 

assignments. Click Next once you have verified the information. 

 

Figure 69.   

Summary of AI RF profile assignment to a site 
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Step 8: Choose when to deploy the AI RF profile 

AI RF profile deployment can be done now or can be scheduled for a nonoperational hour.  

Selecting Next will push the AI RF profile to the selected WLC and APs once provisioned. As with legacy RF 

profiles, changing or applying an RF profile causes a Control and Provisioning of Wireless Access Points 

(CAPWAP) reset and momentarily disrupts AP connectivity. A warning is displayed, as shown in Figure 71.  

 

Figure 70.   

Deploying an AI RF profile to a site 

 

Figure 71.   

Warning displayed when deploying an AI RF profile to a site 
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Step 9: Verify the assignment 

Verify that the AI RF profile has been successfully assigned to the site. 

● Go to the hamburger menu ( ) and choose Assurance > AI-Enhanced RRM. 

● Use the site hierarchy sidebar and navigate to the site where the AI RF profile is deployed.  

● An AI logo will be shown and the site name will be highlighted, which confirms that the AI RF profile has 

been successfully assigned to the site. 

The next step is to provision the wireless controller and access points. This will put Cisco DNA Center in control 

of the controller and APs and allow AI-Enhanced RRM to take control over the controller RRM. 

 

Figure 72.   

AI logo on the site with the AI RF profile 

Part 6: Provision the wireless controller and access points 

Provisioning devices allows Cisco DNA Center to send manage the device using the configurations in the 

network profile assigned to the site.  

Step 1: Provision the WLC and APs 

On Cisco DNA Center, go to the hamburger menu ( ) and choose Provision > Inventory.  

● Select the checkbox next to the name of the Catalyst 9800 Series Wireless Controller that you want to 

provision.  

● From the Actions drop-down list, choose Provision > Provision Device. 
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Figure 73.   

Provisioning the Catalyst 9800 wireless controller 

Step 2: Assign a site 

In the Assign Site window, click Choose a Site to associate the controller with a site. 

In the Choose a Site slide-in window, select the checkbox next to the site name to associate it with the Catalyst 

9800 controller and click Save. 

You can either select a parent site or individual sites. If you select a parent site, all the children under the parent 

site are also selected. You can uncheck the checkbox to deselect an individual site.  

Click Next. 

The Configuration window appears. 

 

Figure 74.   

Assigning a site to the Catalyst 9800 wireless controller 
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Step 3: Configure the controller configurations 

● Select a role for the Catalyst 9800 Series Wireless Controller: Active Main WLC or Anchor. 

● Click Select Primary Managed AP Locations to select the managed AP location for the primary 

controller (Figure 75).  

● Click Select Secondary Managed AP Locations to select the managed AP location for the secondary 

controller. 

● You can either select a parent site or the individual sites and click Save (Figure 76). 

● Click Next. 

If you select a parent site, all the children under the parent site are also selected. You can uncheck the 

checkbox to deselect a particular site. 

Note:   Inheritance of managed AP locations allows you to automatically choose a site along with the 

buildings and floors under that site. One site is managed by only one wireless controller.  

 

Figure 75.   

Configuring the AP sites managed by the controller 
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Figure 76.   

Selecting the site/area for the managed AP location 

Step 4: Assign a model configuration (optional) 

In the Devices pane, you can search for a model configuration design by entering its name in the Find field or by 

expanding the device and selecting a model configuration design. 

The selected model configuration design appears in the right pane. 

This is an optional step if you want to add a model configuration to your Catalyst 9800 wireless controller on top 

of the existing configuration. Click Next to skip this step. Refer to Design Model Configuration in the Cisco DNA 

Center User Guide for more information on creating and editing network-specific model configurations using 

the Model Config Editor. If no model configuration is assigned, simply click Next to continue. 

 

Figure 77.   

Model configurations for the Catalyst 9800 wireless controller 

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-3/user_guide/b_cisco_dna_center_ug_2_3_3/b_cisco_dna_center_ug_2_3_3_chapter_01001.html
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Step 5: Advanced configuration, select device templates 

The Advanced Configuration window appears, where you enter values for the predefined template variables. A 

CLI template will be used to add all the unsupported configuration templates generated from the Learn Device 

Configuration workflow. You can also use a brand new CLI template if necessary, with more configurations that 

are not supported by Cisco DNA Center. Search for the device or the template in the Devices panel. The 

selected CLI template will be parsed here and will be verified for all field checks that will be pushed to the new 

policy/site tag.  

 

Figure 78.   

Advanced configuration for wireless controller provisioning 

Step 6: Review and verify the summary 

In the summary window, review the following configurations: 

● Device Details 

● Network Setting 

● SSID 

● Managed Sites 

● Rolling AP Upgrade 

● Model Configs 

● Interfaces 

● Advanced Configuration 
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Figure 79.   

Wireless controller provisioning summary 

 

Figure 80.   

Wireless controller provisioning summary (cont.) 
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Step 7: Deploy the configurations  

Click Deploy to provision the Catalyst 9800 wireless controller. 

● To deploy the device immediately, click the Now button and then click Apply. 

● To schedule the device deployment for a later date and time, click the Later button and define the date 

and time of the deployment. 

● To generate a report on the configurations pushed by Cisco DNA Center to the Catalyst 9800 wireless 

controller, select Generate Configuration Preview (Figure 70) and click Apply. 

 

Figure 81.   

Provisioning the wireless controller 

● In the Task Name field, enter a name for the CLI preview task and click Apply. 
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Figure 82.   

Generating a configuration preview 

Step 8: Review the work items 

In the Task Submitted pop-up, click the Work Items link. 

Note:   If you missed the Task Submitted pop-up, click the hamburger menu icon ( ) and choose 

Activities > Work Items. 

 

Figure 83.   

Task Submitted pop-up 

https://www.cisco.com/c/dam/en/us/td/i/400001-500000/440001-450000/440001-441000/440197.jpg
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Step 9: Review the CLI task 

In the Work Items window, click the CLI preview task for which you submitted the configuration preview 

request. 

 

Figure 84.   

Work Items list 

Step 10: Review the CLI configuration and deploy the template 

View the CLI configuration details and click Deploy. 

 

Figure 85.   

CLI preview of the Catalyst 9800 configurations 
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Step 11: Choose when to deploy the device 

● To deploy the device immediately, click the Now button, and then click Apply. 

● To schedule the device deployment for a later date and time, click the Later radio button and define the 

date and time of the deployment. 

 

Figure 86.   

Provisioning the Catalyst 9800 wireless controller 

Change the Focus to Provision in the Inventory window and select the site you wish to see the status for. The 

Provisioning Status column displays the device’s current status. In this example, the Catalyst 9800 wireless 

controller with AI-Enhanced RRM controller has already been provisioned.  

 

Figure 87.   

Catalyst 9800 wireless controller Provisioning status in the Inventory window 
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Step 12: Provision wireless access points 

● Click the hamburger menu icon ( ) and choose Provision > Network Devices > Inventory. 

● The Inventory window displays the device information gathered during the discovery process. 

● Select the checkbox next to the AP(s) that you want to provision. 

● From the Actions drop-down list, choose Provision > Provision Device. 

Note:   You can either search for a site by entering its name or expand Global to select the site. Devices 

that are available in the selected site are displayed in the Inventory window. 

To filter the devices based on various criteria, such as device family or reachability status, click Filter, make 

your selections, and then click Apply. 

 

Figure 88.   

Provisioning wireless access points 

Step 13: Assign sites 

In the Assign Site step, configure the following parameters: 

● Click Choose a floor and assign an AP to the site. 

● In the Choose a Floor slide-in pane, select the floor where the AP resides, and click Save. 

● Click Next. 
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Figure 89.   

Assigning floors on sites to wireless access points 

Step 14: Configuration 

On the Configuration page, RF profile and AP zone names are selected. As we have already assigned an AI RF 

profile for the site and have no AP zones defined in the network profile, these values are grayed out here. Click 

Next. 

 

Figure 90.   

Wireless access point configurations while provisioning 
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Step 15: Review and validate the summary 

In the Summary step, review the device details and click Deploy to provision the AP. The Provision Device 

slide-in pane appears. It shows the RF profile being assigned to the wireless access points.  

 

Figure 91.   

Wireless access point provisioning summary 

Step 16: Choose when to deploy 

In the Provision Device slide-in pane, do the following: 

● To immediately deploy the device, click the Now button, and then click Apply. 

● To schedule the device deployment for a later date and time, click the Later button and define the date 

and time of the deployment. 

● To preview the CLI configuration, click the Generate Configuration Preview button (Figure 92). 
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Figure 92.   

Generating a configuration preview for access point provisioning 

Step 17: Monitor the task 

In the Task Submitted pop-up, click the hamburger menu icon ( ) and choose Activities > Work Items. In the 

Work Items window, click the CLI preview task for which you submitted the configuration preview request.  

 

Figure 93.   

Access point provisioning CLI preview in Work Items 

https://www.cisco.com/c/dam/en/us/td/i/400001-500000/440001-450000/440001-441000/440197.jpg
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Step 18: Deploy 

View the CLI configuration details and click Deploy. 

 

Figure 94.   

Reviewing the CLI preview of access point provisioning 

Step 19: Choose when to deploy 

● To immediately deploy the device, click the Now button, and then click Apply. 

● To schedule the device deployment for a later date and time, click the Later  button and define the date 

and time of the deployment. 

 

Figure 95.   

Provisioning a wireless access point 
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Step 20: Verify the provisioning status 

Change the Focus to Provision in the Inventory window and select the site you wish to see the status for. The 

Provisioning Status column displays the device’s current status. In this example, the Catalyst 9800 wireless 

controller and wireless access points with AI-Enhanced RRM controller have already been provisioned.  

 

Figure 96.   

Successful access point provisioning 

Part 7: Verify the AI-Enhanced RRM deployment  

Cisco DNA Center verification 

Go to the Enhanced RRM page and select the site with the AI RF profile. The AI-Enhanced RRM controller 

should be up and should be collecting data from the controller and access points.  
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Figure 97.   

AI-Enhanced RRM control center 

Catalyst 9800 wireless controller verification 

Step 1: Verify the RRM group leader 

On the Catalyst 9800 controller, go to Configuration > RRM > 6 GHz, 5 GHz, or 2.4 GHz Band > RF Grouping.  

● The Group Role should be Remote-Member. 

● The Group Leader should be the Cisco DNA Center’s IP address.  

 

Figure 98.   

Verifying the RF group leader 
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Step 2: Verify the AI-RF profile assigned to the access points 

Go to Configuration > Access Points > Client on an access point that is part of the AI RF profile.  

● The Tags section in the top right should have the AI RF profile in the RF tag. 

● Any new policy/site tags created by Cisco DNA Center will be seen here.  

 

Figure 99.   

Navigating to access points 

 

Figure 100.   

Cisco DNA Center-created configurations on the Catalyst 9800 wireless controller post-provisioning 
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Day-1 AI-Enhanced RRM features and use cases 

The heart of the AI-Enhanced RRM management is the RRM control center, where information regarding the 

current (Latest) and Trend information regarding current actions and overall performance can be viewed.  

Each element on the dashboard has tool tips that explain what it means or how it's measured.  

At the top of the page are the focus selections. This sets the context for the information being displayed on the 

page. Selections for timespan are 24 hours, 7 days, or 14 days (the current maximum data period). The band 

selection (2.4, 5, or 6 GHz) and AI RF profile in use are also shown here.  

 

Figure 101.   

Selecting the focus and context of the RRM control center 

Hero bar and headlines  

Below the focus selections are the headlines regarding the RF coverage and performance, which includes the 

overall RRM performance score (0 to 100, with 100 being excellent) as well as highlights such as the 

percentage of APs with high co-channel interference (CCI), and the count of RRM changes being made. The 

RRM coverage summary looks at the AP density (the number of AP neighbors seen at or above -70 dBm) and 

connectivity (the average client signal-to-noise ratio [SNR]).  

 

Figure 102.   

The AI-Enhanced RRM “headlines” 

Insights  

One way that AI-Enhanced RRM truly distinguishes itself from Cisco’s already powerful industry-leading RRM is 

the AI and ML components, along with the ability to store and use historical telemetry data and establish what is 

“normal” for a given observation over time. RRM on the controller has always been limited to viewing the 

current conditions, as the data storage requirements were quite high.  

 

Figure 103.   

AI-provided actionable insights into system performance and configuration 
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Insights displayed here may be blank initially but will populate after an initial week of learning. AI will look at 

multiple aspects of the configuration and measure against the performance. One example of learned data is the 

busy hour configuration initially set in the AI RF profile. The initial busy hour was configured when the AI RF 

profile was created and assigned. Over time, and with clients on the network, AI-Enhanced RRM observes 

when busy hours (when the network is under load) occur and may suggest an enhancement to the AI RF profile. 

Selecting the insight test will lead you to where the configuration can be changed. The administrator always has 

control of when to redeploy or assign the changed profile to the site. AI will provide insights on Tx power, 

channel bandwidth, DCA settings, AP density, SNR, etc.  

 

Figure 104.   

Applying insights to the AI RF profile 

Note:   For busy hour insight to be generated, there will need to be a difference of at least five clients 

between the minimum and maximum number of clients – and there must be traffic on the network. 

Sleeping clients do not count.  

In the next section, each of the performance metrics from the headlines is broken out into useful widgets, which 

let you explore the context of each down to the contributing radios and APs making up each component.  

Note:   The RF performance matrix will not show radios that are powered down or in power save mode.  
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Figure 105.   

AI-Enhanced RRM performance widgets 

RRM Changes  

In AI-Enhanced RRM, the Latest display always shows the current 30-minute AI-Enhanced RRM run period 

results. On a small network (this one has five APs total), there may not be any changes in the last reporting 

period so the display will show 0. Trend shows the full span for the currently selected time period (24 hours or 

7 or 14 days) and allows the cursor to focus on a specific time in the chart to see how many of each kind of 

change were made. Selecting View Details further expands the selection to include the APs that were affected, 

and selecting an AP shows the actions that were taken in the RRM change made.  

You can export the RRM changes into a CSV file for review.  

 

Figure 106.   

RRM changes: Trend and detail views provide visibility into AI-Enhanced RRM’s actions 
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Figure 107.   

Exporting RRM changes to a CSV file 

 

Figure 108.   

RRM changes in a CSV file 
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RRM Performance 

RRM Performance tracks the performance score and how it changes over time. RRM Performance consists of 

multiple scores measuring co-channel interference, near-channel interference, and duty cycle. The default 

Latest view shows the results as of the last RRM run (30 minutes). Trend displays a trend line and transitions for 

all APs contributing to the scores and allows selection of a specific point in time. Selecting View Details shows 

all the APs included in the score at any point in time. Note the Export button, which will send any of the chart’s 

data to a CSV file for download. Selecting any access point cross-links to the Device 360 view to further 

investigate the AP’s history and behavior.  

 

Figure 109.   

RRM Performance trend detail views – visualize transitions in AP RF health scores 
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Figure 110.   

RRM Performance detail views 

The Co-Channel Interference widget follows the same pattern, with Latest showing the data from the last 30-

minute interval and Trend detailing the channel currently in use, an impact score (based on the duty cycle and 

RF distance of co-channel neighbors), the CCI values in dBm, and the channel duty cycle (at that point in time)  

 

Figure 111.   

Co-Channel Interference trend data helps visualize the co-channel interference scores of managed APs 
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Figure 112.   

Co-channel interference data 
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Figure 113.   

AI-Enhanced RRM control center 
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In the full RRM control center view, AP Spatial Density visualizes the neighboring AP/radio density in the RF 

neighborhood as the number of neighbors that can be seen at or above -70 dBm.  

The Power Distribution chart visualizes power distribution across the networks and provides a corresponding 

neighbor count to correlate AP density with power assignments. Trend allows visualization of history for up to 

two weeks. Selecting a time on the trend line opens the detail for that point in time, listing the contributing APs.  

Utilization per Channel shows the channel utilization. Trend allows visualization of history for up to two weeks. 

Selecting a time on the trend line opens the detail for that point in time, listing the contributing APs.  

AP and Radar per Channel breaks out the channel assignment spread by AP count. Radar detected is displayed 

on impacted channels for context.  

RRM simulator 

The RRM simulator enables the network operator to preview the impact of RRM changes on the live network. 

When Cisco DNA Center recommends RRM setting changes through its Insights feature, or when the network 

administrator plans changes to settings such as channel, channel width, and power, the network administrator 

will be able to: 

● Simulate how the RF environment will respond to the changes 

● Analyze the impact of potential changes during a particular time interval 

● View the proposed changes measured in quantified statistics, including RRM health, co-channel 

interference and utilization, and RRM changes 

Step 1.  To use this feature on Cisco DNA Center, go to the AI-Enhanced RRM control center by choosing 
the hamburger menu and selecting Assurance > Enhanced-RRM. Select the site where you want to try 
these changes using the RRM simulator. Click Run RRM Simulation from the hero bar. 

 

Figure 114.   

Location of RRM simulator on AI-Enhanced RRM control center 
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Step 2.  Click Create Simulation from the Welcome to RRM Simulator page 

 

Figure 115.   

Create Simulation button on RRM simulator 

Step 3.  Make the changes necessary to the simulation profile you need to analyze.  

● In this case, we will change the DBS from 40 MHz to 80 MHz.  

● Click Run Simulation to simulate RF performance data for the newly modified RF settings.  
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Figure 116.   

Changing the AI RF profile before running the simulation 
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Step 4.  The simulation result is displayed as shown in the figure below. All the widgets tagged as 
UPDATED have changed after the RF settings modification. You can compare the simulated RF 
performance data with your current RF performance data by selecting the Compare to AI RF Profile 
checkbox. 

 

Figure 117.   

RRM simulator result after making changes to AI RF profile 
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Step 5.  You can compare all the widgets between the simulation and deployed AI RF profile for this site. 
The comparison is shown below. You can select Upgrade AI RF Profile if you wish to add these changes to 
the current AI RF profile. Select Cancel if you do not wish to make the changes.  

 

Figure 118.   

Comparing the simulation result with current RF performance parameters  



 

© 2023 Cisco and/or its affiliates. All rights reserved. Page 91 of 92 

 

Figure 119.   

Comparing the simulation result with current RF performance parameters (cont.) 
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Useful links 

Cisco DNA Center User Guide, Release 2.3.4 

● https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-

management/dna-center/2-3-4/user_guide/b_cisco_dna_center_ug_2_3_4.html 

Cisco DNA Center information 

● https://www.cisco.com/site/us/en/products/networking/catalyst-center/index.html?dtid=osscdc000283 

Cisco Catalyst 9800 Series information 

● https://www.cisco.com/c/en/us/products/wireless/catalyst-9800-series-wireless-controllers/index.html 

Cisco Catalyst 9100 information 

● https://www.cisco.com/c/en/us/products/wireless/catalyst-9100ax-access-points/index.html 
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